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PRODUCT REVIEW

QCharts
A Real-Time Internet Service

QUOTE.COM, INC.
850 North Shoreline Blvd.
Mountain View, CA 94043-1931
Phone: 800 498-8068, 650 930-1000
Fax: 650 930-1111
E-mail: info@quote.com
Internet: http://www.quote.com
Product: Real-time financial market
information and live charts via the
Internet for stocks, options, commodity futures, mutual funds, and indices
for US and Canadian markets.
Equipment requirements: Wintel
PC–Pentium 90 or greater, 16 MB
RAM, Windows 95 or NT, Internet
connection (via dialup or LAN),
Internet Explorer recommended.
(QCharts has a built-in browser
window that uses Internet Explorer. If
you don’t have Internet Explorer,
QCharts will work fine, but the
browser window within it will not.)
Price: $79.95 a month or $799
annually for QCharts plus exchange
fees; $99.95 a month or $959.50
annually for QCharts Premium
package. Delayed quotes and charts;
free starter package.
by Stuart P. Evens
uote.com, an online financial market information
Website, provides flexibility in its financial data
products to meet the needs
of many different types of investors and
traders. This flexibility is expressed not
only in the variety of data if offers, but
also in how quickly data can be retrieved, and in the many ways it can be
formatted and displayed on your screen.
In fact, in our Readers’ Choice Awards
published in our 1999 Bonus Issue,
Quote.com finished in the top six under
our “favorite Websites” category.
Data available from Quote.com in-

Q

In all, Quote.com offers nine premium packages to choose from,
each with different combinations of data to meet different traders’
needs.

cludes quotes and charts for
stocks, options, commodity
futures, mutual funds and indices for US and Canadian markets.
You can also get business and financial
news headlines and news stories from
top sources, including Reuters, Standard
& Poor’s, BusinessWire, PR Newswire,
Mar-ketscope, Newsbytes, AP Online,
Comline, EDGAR Online, Dow Jones
Online, News, AFX, Nightly Business
Report, and Gomezwire. Earnings forecasts and reports, market analysis and
commentary, options analytics, and
weather information are available as
well, as are company profiles, fundamental data, annual reports, SEC filings,
insider trades, and historical charts.
Mutual fund investors have as options
Lipper Analytics, Morningstar reports,
and mutual fund screening. Bond pricing is also available.

QUOTE.COM PACKAGES

over the Internet, with no satellite dishes,
cables, or hardware.
You can sample the versatility of
Quote.com’s products before subscribing by accessing its free delayed-data
Website at http://fast.quote.com/fq/
quotecom/quote. Along with delayed
NYSE, AMEX NASDAQ prices, you’ll get
company and market snapshots, news,
and LIVE! Charts, which are streaming
charts that don’t require reloading to
update.
LIVE! Charts is a good way to get a feel
for QCharts before you subscribe, as the
Java applet used in LIVE! Charts (Figure
1) is powered by the same technology as
that used in QCharts. Some of the same
tools offered in QCharts, such as simple
moving averages, live US stock market
watch, and news headlines are available
in LIVE! Charts as well. You can also
now get streaming real-time quotes in
the LIVE! Charts applet.

For delayed quotes and financial information, you can start with Quote.com’s
free basic service package, and then add
services as your needs change. The ad- QCHARTS
ditional monthly cost depends on which I installed and tested QCharts using a
packages, if any, you add to your basic T-1 line on an HP Vectra VL Series 3
service. Premium services can be
added when you first sign up or at
any time in the future. Not unexpectedly, the more data you want, and the
quicker you want it, the more it costs.
However, prepaying annually can get
you a discount of up to 38%.
QCharts is Quote.com’s real-time
financial information package.
QCharts Premium adds fundamental
information to the real-time data
package. In all, Quote.com offers
nine premium packages to choose
from, each with different combina- FIGURE 1: LIVE! CHARTS. Quote.com’s LIVE! Charts feature is
tions of data to meet different trad- a good way to sample the versatility of Quote.com’s data products.
ers’ needs. But regardless of sub- LIVE! Charts provide real-time streaming data for several indices,
scription choice, data is delivered such as the Dow Jones Industrial Average.
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5/75 machine. I found the installation
quick and easy, as the instructions are
clear and easy to follow. Once the
program is installed and running, information on nearly every feature of
QCharts is available through the help
command. A list of QChart features
can be seen in Figure 2.
The QCharts package is downloaded
online, unless you prefer not to give
your credit card number over the
Internet, in which case Quote.com gives
you the option of signup by phone.
After registration, Quote.com will Email you an activation code, which I
received within an hour. After that, you
go to the Quote.com homepage, click
on “Account activation,” and follow the
instructions using your preselected login
name and password.
To activate the QCharts portion of your
service, you must download the SetupQCharts.exe file to your desktop, which
doesn’t take long. After running SetupQCharts, a shortcut to QCharts will appear
on your desktop. Click on this icon, enter
your Quote.com user name and password,
and you’re off and running.
But before you can access real-time
data, signed exchange subscriber agreements must be received by Quote.com.
These are required by each exchange
from which you want real-time quotes.
Once Quote.com receives your signed
agreements, they will notify you by Email that your real-time subscription has
been activated. In my case, I received Email notification less than a week after
mailing the subscriber agreement forms.
When you log onto QCharts, the first
screen you see is a workspace called
MarketWatch (Figure 3). A workspace
is a screen with data arranged in convenient windows. In addition to MarketWatch, other presaved workspaces can
be displayed. Prepackaged workspaces
can be customized by the user and saved
as new, or you can start from scratch
and build a new one by adding windows
and data within each window.
Each workspace is controlled by
toolbars. As you create and save
workspaces, you can control their appearance and content through choices
in the File menu. You can save multiple
workspaces, but you can only have one

open at a time. Upon exiting each
workspace, you have the option of saving any changes made during the session. When you log back onto QCharts
for your next session, you will also be
given the option of picking up where
you left off the previous time.
Clicking on View on the main menu
allows you to set preferences for displaying toolbars and other features.
Here, you can also set alerts, specify a
homepage for the embedded browser,
and designate your online broker page
where you do your online trading.
When you highlight (or activate) one
of the windows on your workspace, the
menu selection changes according to
what you have highlighted. For example,
if you activate the chart window, the
Chart and Study menu choices appear.
If you click on the portfolio window, the
Quote Sheet menu appears.
Common to all windows on the
workspace are Alerts, Window, and
Help. Clicking on Alerts allows you to
view, set, and delete alerts. The Window menu allows you to choose how
windows are arranged on your workspace. Under Help, you can choose a
topic or use the search function.
The peripheral toolbars are not only
used for modifying workspaces, but also
for accessing QCharts’ main features.
A single click opens a new chart, a time
& sales window, or hotlist. Access to

SOME QCHARTS FEATURES
MarketPulse real-time feed
Real-time security information
Two customizable portfolios
Live portfolios and charts (real-time
streaming)
25 earnings and economic statistics
reports daily
Stock and index option analysis and pricing
Real-time and historical news headlines
Full-text news from Newsbytes News
Network
Nelson’s company profiles
Ticker symbols and company name searches
Unlimited daily, weekly, or monthly charts
for individual stocks
Customized charts
Market index charts
10 long history datafiles per day
25 end-of-day data updates daily
Daily market mover data
Mutual fund data
Mutual fund screener
International market data
25 annual reports mailed daily on
3,000 companies
FIGURE 2: QCharts covers all North American stocks,
options, and futures. Here are just a few of its features.

CHARTS
From the Chart toolbar (Figure 4), you
can choose bar, candle, or line charts, as
well as display open, high, low, last
trade, trade size, net change, and percent net change, and through a submenu,
date, time, open, high, low, close, volume, and moving average values on the
chart. The cursor tracking button on the

Data is available from Quote.com in combinations
for virtually any type of investor or trader, from
delayed data for longer-term investors to tick-bytick data for daytraders. The cost is reasonable
and the reliability of the service is excellent.
your browser for news and your online
brokerage are also just a click away.
The Expression toolbar is used to enter
symbols or companies for quotes and chart
displays. The interval of each price bar can
be set to yearly, quarterly, monthly, weekly,
daily, 60-, 30-, 15-, 10-, five-, or one-minute
bar, or you can simply type in the number of
minutes that you want each bar to represent.
For futures traders, the All Sessions checkbox
can be switched on to view both day and
overnight trading sessions.

toolbar gives you a data readout of your
cursor position on the chart, and you can
change the price scale to a log scale and
switch on the volume display.
Technical indicators were not yet
available in the version of QCharts I
reviewed, though they are available in
the LIVE! Charts Java applet and in the
beta version. Those indicators include
averages (simple and exponential),
Bollinger bands, Donchian channels,
moving average convergence/diver-
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gence (MACD), MACD histogram, stochastic, relative strength indicator (RSI),
rate of change, momentum, and onbalance volume. Simple moving averages are available.
With the chart window activated, you
can modify the chart window, and from
the Study menu, add or delete moving
averages, which are updated as new price
bars are added. You can have multiple
moving averages on one chart, and you
can choose the period, color, offset, and
thickness of the moving average lines.
Historical price action can be viewed
by clicking on the chart and dragging
the price bars along until the period you
want is in view. This can be done in any
periodicity.

TIME & SALES WINDOW
The Time & Sales window allows you
to see every trade, bid, asked, correction message, and corrected data for
every instrument on the market feed
(Figure 5). Trade size and time of occurrence; bid, asked, and size of each are
also displayed and updated in real time.
This data is provided by Quote.com’s
Continuum servers, from which data
can be accessed back to April 8, 1997.
Each bit of information is date- and
time-stamped to the second and can be
viewed historically or as it occurs in real
time during the trading day. You can
customize the display to filter trades so
that only trades meeting your criteria are
displayed.
Rows of information in
this screen are color-coded
to highlight data or events.
Routine trades are shown
in plain white; red shows a
trade executed at the low
price of the day, and green
shows the high; black is an
out-of-sequence trade or an
after-hours Form-T trade;
dark gray highlights a bid
price, while light gray is
an asked price.

QUOTE SHEETS
A quote sheet looks like a
spreadsheet (Figure 6) and
allows you to view various
markets and multiple bits

of data within each market at the
same time. The security symbols are
in the first vertical column on the
left, and the data categories extend
out to the right of each symbol,
known as quote sheet fields. By rightclicking on the column heading, a
menu of 39 choices of data values is
displayed, including open, high, low,
tick (up, down, same), yesterday’s
close, bid, ask, volume, trade size,
and so on.
Fields in the quote sheet are colorcoded. For example, green in the
tick field means an uptick, while a
green net field means a gain over
yesterday’s close; red, a downtick
and loss. A yellow field signifies the
cell is being updated, and a black
field indicates data for this field is
not available.
Quote sheets can be customized using drag-and-drop to arrange data and
symbols, to copy a symbol to another
quote sheet, or to activate a new symbol
in a chart window. This way, data and
symbols can be moved quickly around
the workspace.
The Quote Sheet menu is used to
access hotlists, sort quote sheets, and
import and export symbols. Symbols
can also be imported from a text file
and can be exported in the spacedelimited, tab-delimited, or commaseparated format.
New quote sheets are created

FIGURE 5: TIME & SALES WINDOW, FORD MOTOR. The time
& sales window for Ford Motor lists every trade, bid, ask, and
correction as it happens. The data displayed in each column (bid,
ask, etc.) is chosen from a pulldown menu that appears when you
click on the heading of each column. The rows highlighted in green
represent trades executed at the high price of the day. The
different shades of gray represent various bid/ask prices.

FIGURE 3: MARKETWATCH WORKSPACE. The first screen you
see in QCharts is the Marketwatch workspace. This screen can be
customized with the data you want to see and saved for future use.
Or you can start from scratch and build your own workspace by
adding various windows and data within each window.

FIGURE 4: CHART WINDOW, NETSCAPE. Chart attributes can
be controlled by the chart toolbar, which is activated when you
click anywhere on the chart. Two simple moving average studies
are shown on this bar chart for Netscape, and pertinent values for
both the stock and the moving averages are displayed in the
upper-left of the chart. Current values for the last trade and
moving averages are shown to the right. These color-coded
values are updated in real-time.

FIGURE 6: QUOTE SHEET. The quote sheet with color-coded
fields lists securities you want to follow. This screen is from after
the close, so the fields highlighted here are different from what you
would see during market hours. Unlike on the hotlist shown in
Figure 7, these securities will remain on the quote sheet until you
delete them.
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through the File menu or by clicking on
the toolbar. A security is added to a quote
sheet by simply typing a symbol or company name in a blank cell in the first
column.

HOTLISTS
Each trading day, Quote.com’s Continuum servers monitor the market for
notable market action and produce
hotlists (Figure 7) that meet certain criteria. Thinly traded issues are filtered out,
and to make a top-100 list, the volume
must be at least 100,000 shares with a
minimum of 50 trades. Hotlists are displayed like a quote sheet, but the symbols in the hot sheet are updated every 30
seconds by Quote.com’s server. That
way, you always have the top movers for
any category during the trading day.
The Quotes toolbar is used to select
hotlists and allows you to import and
export symbols into and out of the quote
sheet. Clicking the Hot button produces

a window with various hotlists, such
as highest-volume stocks, largest
point gain/loss, new yearly highs/
lows, or largest range, to name a few.
You can sort quotes based on criteria
such as ascending or descending by
symbol, title, high, low, and so on.
You can transform a hotlist into a
quote sheet and vice versa. If you see
an interesting stock while viewing a
hotlist, just drag and drop it from the
hotlist into a quote sheet.

SUMMARY

FIGURE 7: HOTLISTS. With hotlists, the securities will automatically update before your eyes according to market conditions,
depending on the criteria you set. The criterion here is the number
of trades. Securities not meeting the criteria will be instantly
replaced in the list by more active stocks.

Quote.com does an excellent job of
providing financial data, and
QCharts is great for real-time charts
and quotes. Data is available from
Quote.com in combinations for virtually any type of investor or trader,
from delayed data for longer-term investors to tick-by-tick data for
daytraders. The cost is reasonable and
the reliability of the service is excel-

lent. For those who want real-time
data without the additional hardware,
Quote.com deserves a look.
Stuart Evens is a Staff Writer for STOCKS
S&C
& COMMODITIES.
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FOR MORE INFORMATION REGARDING QUOTE.COM QCHARTS, PLEASE E-MAIL QCHARTS@QUOTE.COM.

